Release Note

Release Date : Mar. 2022
Product Ver. : midas Gen 2022 (v1.1) and Design+2022(v1.1)

DESIGN OF General Structures

Integrated Design System for Building and General Structures



Enhancements

* midas Gen

1) New American RC Code : ACI318-19 (for US.SI)

2) Beam-Column Joints check for Existing Building as per NTC2018
3) Crack Control Check for RC Column as per EC2:04 & NTC

4) SCWB Design/Checking Method Option as per ACI Series

5) Thailand Code : DPT (Wind and Seismic load)

6) Addition of Thailand DB(TIS for SI,MKS)

7) Addition of Taiwan DB (CNS560-18)

8) Addition of Indonesia DB(SNI)

9) Earthquake Scaling Calculator

10) Preview function of Start Page

11) Revit 2022 Interface
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https://globalsupport.midasuser.com/helpdesk/KB/View/32493617-new-gen--v-installation-and--patch-files
https://landing.midasuser.com/en/gate/building/trials/gen/step1
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midas Gen | Gen 2022 v1.1 Release Note

1. New American RC Code : ACI318-19 (US.SI)

Added ACI318-19(US)/ACI318M-19(SI) Code for RC Design

7 Preview Window - o x

Concrete Design Code

|
L/

No:111 ~ & Pint & Print Al 3 Close I Save

1. Design Condition
Design Code ACI318M-19 UNITSYSTEM : kN, m
Member Number - 54 (PM), 54 (Shear)

Meaterial Data fo=24000, fy =689476, fys =275790KPa

Column Height - 5m

Section Property : TC1 (No:111)
Rebar Patten 34-8-D22

Design Code : ACI318-19

ACI318M-19
heck Beam Deflection

Apply Spedal Provisions for Seismic Design Ast=00131614 7 (pst=0.010)

Axial and Moments Capacity

Load Gombination : 24 (Pos : 1)

ConcentricMax Axial Load @Pn-max =18369.5kN

Axial Load Ratio PulgPn =12173.1718369.5 =0863<1.000

Moment Ratio M/ ghin =524475/854 330 =0614 <1000
Moy | phiny =-50559/ 823.565 =0614 <1000
Mez | phinz =-139.48/ 227 202 =0614 <1000

IE‘Se\srmc Design Parameter
Select Frame Type

T

(®) spedal Moment Frames
() Intermediate Moment Frames
O Ordinary Moment Frames

T

P-M Interaction Diagram
PO
(N orsc0 FPAKN)  gMAGkN-m)
22061.28 0.00
18620.63 1456.04
15508.66 2751.25
1217272 3528.49
911542 4010.21
640712 4106.92
491842 4103.97
421328 4300.03
2816.98 4537.58
59730 4455.05
244765 3196.59
588114 141304
-8167.02 0.00

Consider strong column-weak beam on last floor
Shear Wall Type
Spedial RC Structural Wall
Boundary Element Method
(®) Displacement Based Method
Deflection Amplification Factor {Cd)
Important Factor (Ie)
() Stress Based Method

Shear for Design
Design Result Table

ACI318M-19 RC-Celumn Design Result Dialeg

Code : ACI318M-19 Primary Sorting Option

Sorted by () Member SECT MEMB
@ Property

MEMB sz Section fc fy Pu Mc T Yu.end | Rat-V.end | As-H.end| H-Rebar.end
| -Rebar
SECT Bc I Hc | Height fys Rat-P | Rat-M Vumid | Rat-V.mid | As-H mid | H-Rebar mid

o r c1 24000.0 | 589476 6783.16 | 134.361 298022 218.357 0.308 0.0000 2010 @140
104 D.BDD| 1.000| 4.0000 | 275750 0.626 0.538 218.357 0.305 0.0000 2010 @140

0 c1 24000.0 | 689476 4784.04 | 198.064 186027 218.233 0.354 0.0000 Z-D10 @140
105 U.SUU| 0.800( 4.0000 | 275750 0.548 0.500 218233 0.352 0.0000 2010 @140

0 r C1 24000.0 | 689476 959.745 | 544.436 s 197.537 0.583 0.0008 | 2-D10 @180
106 D.BDD| 0.600( 4.0000 | 275750 0.593 0.558 197.537 0.589 0.0008 | 2-D10 @180

T

T

1

PVY

3

¥ (LCB:73,POS: J) 2(LCB:43,POS )

142904 L0 2958 991 L\

L

= MEMBER NAI|

Detail Report

1. Member Infor$

]
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midas GEN |

1. New American RC Code : ACI318-19 (US.SI)

Added ACI318-19 Load combinations

For Concrete Design

Automatic Generation of Load Combinations

Option

®add O Replace Add Envelope

Code Selection

() steel (®conarete (JSRC
() Cold Formed Steel () Footing
() Aluminum

o

Gen 2022 v1.1 Release Note

Provision

Load factors and combinations

Design Code :

ACI318-19 ~ I

ESGIE Up of Response Spectrum Load Cases

L]

Factor Load Case Add

1130 RX Modify
1540 RY

Scale Up Factor :

Delete

Wind Load Factor

(®) strengthlevel () Service Jevel

Consider Lateral Soil Pressure Factor

Manipulation of Construction Stage Load Case

ST Only CS Only ST+CS

Consider Orthogonal Effect

[ Set Load Cases for Orthogonal Effect...

@100 : 30 Rule
SRSS(Square-Root-of-Sum-of-Squares)
Generate Additional Load Combinations
for Special Seismic Load
for Vertical Seismic Forces

Factors for Seismic Design...

Will Execute Construction Stage Analysis
Consider Losses for Prestress Load Cases

1

1

OK Cancel

Strength
Load Combinations

1.4 (D+F)

1.2(D+F+T) +1.6(L+H) + 0.5(Lr or R)

1.2D +1.6(Lr or R) + (1.0L or 0.5W)

1.2D + 1.0W + 1.0L +0.5(Lr or R)

12D £+ 1.0E+1.0L

0.9D £ 1.0W + 1.6H

0.9D *= 1.0E + 1.6H

Allowable stress
Load Combinations

D+F

D+H+F+L+T

D+H+F+(LrorR)

D +H+F +0.75[L+T(Lr or R)]

D+H+F+ (0.6WorE/1.4)

Special load
combinations

1.2D + 1.0L +1.0Em

0.9D + 1.0Em

: Dead Load
: Fluid Load
: Temperature Load

. Lateral pressure load of soil and water in soil

: Live load
Lr : Roof live load
R : Rain load
W : Wind load

E : Earthquake load (=Eh + Ev)
Em : maximum effect of horizontal and vertical ea

rth-quake force (=QyEh)

Q,: Seismic force amplification factor
Eh : Horizontal earthquake load
Ev : Vertical earthquake load (not provided in Gen2

022 v1.1)
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midas Gen | Gen 2022 v1.1 Release Note

1. New American RC Code : ACI318-19 (US.SI)

Added New Rebar DB and Material as per ASTM19

Set Rebar Material Rebar DB as per ASTM19 & Design rebar setting

Preferences x Rebar Infermation b
= Environment Design Code 1 Load Code
. General Steel Conaete SRC Rebar Code ASTM
g'::; Tolerances Design Code: Design Code: Design Code:
) AISC(15th)LRFD1E v ACI318-19 v Dia Area Dia(Cut) Weight &
Property v
oud | SSREP EL s LT | (in®) (in) (kipsfin)
- Results Recommended Italy Rebar
- Design/Load Code T —— Rebar Material Code I:l #3 0.3750 0.1100 0.3750 0.0000
Notce B Do code: Materil Code ATMBRD) v 0 # 0.5000 | 02000 | 0.5000 0.0001
L Outpet romats Ewrocode3-13:06 v . ] #5 0.6250 0.3100 0.6250 0.0001
::ormat: - Eim. & Others Mational Anl;e:;: Grade 40 i D H#E 0.7500 0.4400 0.7500 0.0001
- FOrmal -Forces Recommende: hd
i Grade 0 [ #7 0.8750 0.6000 0.8750 0.0002
Grade 80 [] #8 1.0000 0.73900 1.0000 0.0002
Grade 100
] #9 11280 1.0000 11280 0.0003
7 save Changes Upon oK DefaktMl || setbefan X — 0 #10 | 1.2700 | 12700 | 1.2700 0.0004
: ] #11 1.4100 1.5600 1.4100 0.0004
[] #14 1.6830 22500 1.6930 0.0006
Rebar strength as per ASTM 19 O] | #18 | 22570 | 40000 | 22570 0.0011
Tensile Strength Yield Strength
Fu (psi) Fy (psi)
Grade 40 60,000 40,000
Grade 60 80,000 60,000 v
Grade 80 100,000 80,000 O
Grade 100 117,000 10,000

Y/
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Gen 2022 v1.1 Release Note

midas GEN |

2. Beam-Column Joints Check for Existing Building as per NTC2018

Beam-Column Joints Capacity Check for Existing Building

» Design > result > Concrete Design > Existing Joint Check

hover LSl Quey  Tools Result Table for Joint Capacity check for existing building

E . - |‘ .
% Section for Design | 11 5Steel/Cold Formed 5teel Desi Beam-Column Joint Check for Existing Baiding

LFQ Concrete Design v| . y-axis Z-axis
Position > T T Ty = : T Iy

eman: apac eman: apac
[ conerete Design imne) | (uimme) | REmark ummEy | (imn)

Remark

[6G Cydlic Shear Resistance Check Position = Bottom
LF‘ e = Press right meuse button and click "Set Existing Join§Check Parameters’ menu o change

q ETEARE el i Load Case/Combination/Select Check Position
81 Bottom Tensile =igm22 82235 1.50000 MG fei
81 Bottom Compressive  |sism22 8241 12.5'|]'D-D| aK

Set Existing Joint Check Parameters

Set Existing Joint Check Parameters

Demand : Joints Stress, o, and o

Capacity : by Equation below

- per laresistenza a trazione: Tensile stress

Load Case/Combination

ALL COMBIMATION

2 ) 2
Existing Joint Check Table Type aje = | — (%) + (Z—J) < 03/f(f. inMPa)  [C8.7.2.11]
J J J

(@) Show Select=d Elements

— per la resistenza a compressione: Compressive stress
() show Al Elements

2

N v o .

Select Check Position (_24-) + (A—J) < 0.5f.(f.inMPa) [C8.7.2.12]
T 7

(®) Top

Demand s Capacity 2 O.K

Demand > Capacity = N.G.
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Gen 2022 v1.1 Release Note

2. Beam-Column Joints Check for Existing Building as per NTC2018

Beam-Column Joints Check for Existing Building
» Design > result > Concrete Design > Existing Joint Check

Result Table for Beam-Column Joint check for Existing Building

/ .
G

1) This check option is activated only with NTC2018.

Beam-Column Joint Check for Existing Building

y-axis zZ-axis

Position Stress
Demand Capacity Demand Capacity

tumn) | qumney | Remar (uimn) | gumnr) | Remark

Check Posttion = Bottom

Press right mouse butten and click "Set Existing Joint Check Parameters' menu to change
Load Casze/Combination/Select Check Position

2) If ‘Apply Special Provision for Seismic Design’ of
concrete design code is active, this check option can’t
be activated.

This check must be performed only for ‘Not Confined

81 [Bottom  [Tensik [sism2z | 82225  1.5000] NG[sism22 | 50851  1.5000]

Joint’ as defined in §7.4.4.3 of the NTC

81 |Bottom  [Compressive |sism22 | 82471 12.5000] OK|sism22 | 5.0842| 12.5000]

This check is 'existing structure review', so it is
calculated using the beam reinforcement information
entered by the user.

& o

C8.7.2.3.5 Beam and Column for Existing Building as per CIRCOLARE NTC2018

- [Calculation & check of diagonal tensile stress for beam-column joint]

Where,
1) N : Axial force acting on the upper column
(+ : compressive,-:tensile)

[C8.7.2.11] 2y vj : Total shear acting on the joint, obtained as a
sum algebraic of the shear transmitted by the upper
pillar and of the horizontal stresses transmitted by the
upper parts of the beams

[C8.7.2.12] 3)Ai:bj*hjc
where bj and hjc are defined in §7.4.4.3.1 of the NTC

%
<

%
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3. Crack Control Check for RC Column as per EC2:04 & NTC

RC Column Crack Width Check as per EC2:04 & NTC2018

H Seismic Desian Parameter RC Column Check
[~ Beam-Column Joint Design Code : ECZ:04,NTC2018

Gamrma-rd ® Member

() Property
[ Mot Confined Jaint

Unit : M

b Skianath
(®) Serviceahility

Primary Soring Option

Sorted by Re (JSECT @ MEMB

Confined Joint

Gen 2022 v1.1 Release Note

Select Check Position MEWB Seclion | fek fyk Stress Contral

Crack Control

@Tap OBDﬂDI‘I‘I SECT Height| fyw sig-cla | LCB| sig-cc | sig-cca sig-sa

wa_y |LCB

913
106

24.0000
4000.0

550.000
420.000

101 15.8097 | 14.4000 440000

600.0] 600.0

80

Detail Result

([[=]]]

CHECK, SERYICEABILITY CRACK LIMIT ABOUT MAJOR XIS,

Graphic Result

. Serviceability - Stress Limit Check
Conc(Tens.)
101(F)
-11.76
250
Cracked Section

e crack width.

o 2-1- 1EDDgEI3use?34

dppendix B, ]
516411.853 N,
191305395, 40 H-mm
ck+8iHPa ) =
U 30+t ck” 52;’3)—
fotm (by 28 days).
12.82

4,662 MPa.
0.6 (far short tern loading. 1

Conc.(Comp.)
101(F)
15.81
14 40

Crached Section

Conc.,(Comp.)(QP)
87(Q)
15.64
10.80
Cracked Sedtion
Non-linear Creep

Rebar

101(F)

11344

440.00
Cracked Section

Load Gombination
Stress(s)

Allowable Stress(sa)
Stress Ratio(s/sa)
Check Linear Creep

1
When cracked section, 2 b d) (h- x)ia 4%5

. Serviceability - Crack Limit Check DS?E

mox
0 oo
=5-
@
o=
o
=

y (LGB 97, POS: J)
0.06870 mm
0.30000 mm

0.229 < 1.000

z(LCB: 80,POS:J)
0.37293 mm
0.30000 mm
1243>1.000 ... N.G

=22 [fcmﬂ[l] 0.3 1000
. .ﬁ.lpha_e = E=/Ecm
(Slgma 5| kt*fct
{0.000074

. (Eps_sm-Eps_cm)
< 0.6+5igma_s/Es = 0.000194
. (Eps_sm-Eps_cm) = 0.6+5igma_s/Es = 0.000154

00,8000
0.5000
3.4000
0.4280

Crack Width({w)
Allowable Crack Width(wa)
Check Ratio(wiwa)

L T O T T R O A Y I T R B o |

. Bond coefficientikl) .

. 3train distribution coefficient(ke)
. HAD Value %kﬁ%
. N0 Value (kd
. C =

. Phi =
COS_r.max =

5240000 mm
2220000 m
kidwe + kl*kE*kd*Phlx’Rho _p.eff

32.00000 MPa.
2,49610 MPa., (fclk=<=CE0/60)

SDéEBBBfJ .

31188 5'?4 MPa. (by Table 3.1)
eff.e’Rho p eff*(lmlpha exRho_p.eff))/Es

354169534 .

, =35_ r max + { Eps_sm-Eps_cm)
wk < 0300 mm, _——> 0.F

0.06870 mm.
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Gen 2022 v1.1 Release Note

midas GEN |

3. Crack Control Check for RC Column as per EC2:04 & NTC

RC Column Crack Width Check as per EC2:04 & NTC2018

1) The stress check with cracked section is obtained along
each axis in the program. Similarly, crack check is
performed along local axis (y & z axis)

2) In GSD, you can also check actual stress in the cracked
section on bi-axis along with stress in each
reinforcement bar.

3) For calculating effective area of concrete in tension for
circular cross sections (Ac,eff), the program use the
equation by Wiese et al (left side)

Calculating effective area of concrete in tension, Ac,eff ,in program
[ Rectangular and Circular Column]

~

Neutral fiber

Neutral fiber

i ] .o
T A - For determlnlng Em~ Ecm

7‘ 1) &, : The mean strain in the reinforcement under the relevant
combination of loads, including the effect of imposed deformations

and taking into account the effects of tensile stiffening.

2) &., - The mean strain in the concrete between cracks.

Level of centroid

Aca of reinforcement

v
e

Calculate crack width using the following formula as per EC2:04 and NTC

Wk =S5 (€~ €Ecm ) < Wk,max

r.max

1. Determine &,,- €.,

k fct,eff
O — K¢

P peft
E

S

2. Determine S

r.max

+ klk2k4¢
pp,eff

S, max = KsC

3) o, :The stress in the tension reinforcement
4) a, : Es/Ecm.
5) K, : factor dependent on duration of the load.
0.6 for short-term load, 0.4 for long-term load
6) Py eft - As / Ac,eff

- For determining S, j,qx

1) ¢ :bar diameter. The program uses the ¢ of the outer layer.

2) ¢ : cover to the longitudinal reinforcement.

3)k1 : A coefficient accounting the bond properties of rebar (0.8 for
high bond bars)

4)k2 : Coefficient accounting for distribution of strain. (0.5 for
bending)

5)k3 : 3.4 (recommended values)

Q) k4 : 0.425(recommended values)

10/21



midas Gen | Gen 2022 v1.1 Release Note

4. SCWB Design/Checking Method Option as per ACI Series

Added nominal strength method for design force calculation, special provision for seismic design
» Design > RC Design> Design Code > SCWB Design/Checking Method

W useips
SCWB Design/Checking Option 1)

SCWB Design/Checking Method

(") Design Strength (@ MNominal Strength 2) This option can be activated when

(@ ACI 318-19,14 , NSCP-2015: Special Moment Frames in Seismic Design
Parameter

@ NSR-10 : DES(Special Energy Dissipation) or DMO (Moderate Energy
Dissipation) Class in Seismic Design Parameter

The applied codes are ACI318-19,14(including M), NSR-10, NSCP2015

/

1. Column design moment as per selection 2. SCWB Ratio Calculation as per selection
Performing Ductile Design & Checking Performing SCWB Design & Checking

[Design Strength Method] Using the Design strength of beams, ¢,M,,

[Design Strength Method] Using the Design strength of beams and
Column, @pM,,p, DM,

—(® Mce,B
M p —(g) (OpMpp 1 + OpMp r) (L)

Mce,T+Mce,B

. W Ratio = (@cMnc,T‘HDcMnc,B)
Mcr = g) (D6Mub 1, + BpMnb ) <M¢> ObMnp,L+PpMnp,R

ce,T +M ce,B

[Nominal Strength Method] Using the nominal strength of beams, M,, [Nominal Strength Method] Using the nominal strength of beams &
Column , My, My,

MC,B =(§) (Mnb,L + Mnb,R) <MM¢)

ceT +M ce,B

MC,T - g) (Mnb,L + Mnb,R) (L)

Mce,T+Mce,B

Ratio = (

Mnc,T+Mnc,B )
M nb,L +M nb,R
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midas Gen | Gen 2022 v1.1 Release Note

5. Thailand Code : DPT (Wind and Seismic load)

Added DPT.1311-

Wind load Calc. Sheet per DPT1311-05(2007) o /o [

e
Add/Modity Wind Losd Specication ggggﬁ WIND LOADS BASED OM DPT.1331-50:2007 { DETAILED METHOD J [ UNIT: M, mm ]
00004
el Brevm . 00005 . BASIC INPUT DATA
nadlase hame 00005 Desian Code + OPT. 1331-50: 2007
Wind Load Code : | DPT.1331-50:2007 00007 Calculation Method : Detailed Method
2 0000e Wind Zone :
[ Oescrphon - 00005 dverage Roof Height + B0000 .00
00010 Easw W\ng ?uead el 25,00

; 00011 wposure Catedory
(=] W'.“d Foad Parameters 00012 Importance Factor, 1y v l.on
Application Method 00013 Fundanenta| Natural Frequency ¢ Hz ) ¢ Maj .00, Ortho, = 0.00
O Simpliied Methad @ General Mathod oo Danpng Rat o oo, Ortto. ='G.
00018 . BUST FACTOR
U'KHSQ’IUITISG nunsvay Cammon Parameters 00017 La E Major )

Wind Zana Zane 1 > ggglg Cg  Ortho. )

o . 00020 . TOPDGRAPHIC EFFECT
Ha:MSEDIUAUDIUIIDNGETS Basic Wind Speed m/sec 00021 Not Considersd
) - 00022
Ueettn Cefizeyesy ¢ 0003 4. EIUATION FOR WIND LOATS
1,00 v 00024 ind Force
Importance Factor _ i gmd PrﬁSEﬁrE
Topographic Effects gﬁgﬁ estan Wi Fressure
Clinclude Topographic Efects 00028 . SCALE FACTOR FOR UHNIJ LDADS
00029 %-directional Wind Loads : =
Y-directional Wind Loads =

aoao

2D Ridge or Valley
Upwind

iR
00037 Wind Direction

et @® &lang Aoross Tarsional
no03s

00040 ‘
Gust Factars and Pressure Coefficient 00041 Campaneot beleciciie

00042 _Di
#uto Calculate by Structure Information, 00042 @ D!r @® Story Force
00044 O v-Dir O Story Shear

Major Ortha, ggm O ¥ & ¥-Dir (O Overturning Moment
0047 QO B8RES

Additional Parameters 00048

[ &cross Yind i Story A
0050 — Elev. Wind Forc

[ Torsional #ind 333; Roof 50000.0 i 37639.851
‘Wind Response ( Disp, / Accel. ) 00053 12F 46000.0 g 72217.981

T opo:
Parameters of Wind Yibration. .. T MF 42000.0 5 69080 688
10F 38000.0 65858.459

nsns:mméha Rea dy SF 34000.0 L 6253964

Wind Load Direction Factor (Scale Factor) BF 30000.0 I 59109.375

w.d. 2550 %0 [T | v-Dir [0 ] Z-et, 0 I 26000.0 ; 59108.375

BF 22000.0 59109.375
Additional Wind Loads (Unit:i,mm}) SF 18000.0 59108375
Along | Along | Across [‘ >
AddX | Add-y | Add-x File Mame

|D:WDD‘ZDZIEWGEHZDZQ,QErjl ZEWColumn Erackwl 0 1000 accee  soooe 00e

< > Wind Force

Make Wind Load Calc, Sheet Browse

nsulssSmsmawiiioo

Story

Wind Load Profile,,, |——=k—Cancai—}
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midas Gen | Gen 2022 v1.1 Release Note

5. Thailand Code : DPT (Wind and Seismic load)

Added DPT.1301/1302-61:2018 (Seismic Load)

Static seismic Load Response Spectrum

Add/Modify Seismic Load Specification bd Generate Design Spectrum X

g IE )
Seismic Load Code @ | DPT.1301/1302-61:2
USW.130 1/1 302-61 Description © | Region

(®) Bangkok () Regeion except Bangkok
- =] Selgmic Load Parametars
LasTIuUMSaNnuuNI@ISaNUMu Region Method
(® Bangkok () Reqgeion except Bangkok By Graph 1.4.6~7 By Table 1.4-4~5

Method
Ev Graph 1,4,6~7 By Table 1,4-4~5

Design Spectrum : DPT.1301/1302-61:2018

misduaziiouvaonwuaulsd

Seismic Zone

Seismic Zone
Seismic Zone
Seismic Zone 2 Design Spectral Acceleration
Design Spectral Acceleration

5d by Code
0,75 1.2 0.6
0,30 1.8 0,36
1.5

Auto-Draw Response Spectrum Functions
Category

Risk Categary Il > i per DPT1301/1302-61(2018))
Impartance Imporu -

Add/Modify/Show Response Spectrum Functions

Selsmic Deglon Catanar strud

Sds D Res Function Name Spectral Data Type

Define Factors per DPT1301/1302-61(2018) 3 @vomalzedpccel.  Obcceleraton  Oveloaty O Diplacement
W . Damg Sealing Gravity Graph Options
i . = noor e ® scaepacur [5308 Jmmisecs  Cyousiogce

period Calculator s Period | Spectral Data | ~
(@

., (sec)
O Analylical Pg Major Direction Ortho, Direction 0.0100 0.0340

@® Approzimate| @1, T=0,02H { for RC ) @1, T=0,02H ( for AC ) 00260 =
Fundamental Py 2 T2 0.03H ¢ for Steel ) O2 T=003H ( for Steel ) 0.0670 0.0476

0.0860 0.0522
Response Modl (3 T =N < H { User Input ) O3 T=N+H ( User Input ) gusc —
Damping Ratio 01240 0.0613

Seismic Load [ 0,025 0,05 9] 01820 0.0704

10 01810 0.0750
*-Direction : E I 11| 0.2000 0.0795

et 12| 02300 0.0825 5
Accidental Ecc 13| 02600 0.0856 .01 0.51 1.0L LS 201 251 2.01 3.5 .00 451 5.0 S

Beriod (sec)
i I:l i e vosssl ¥
¥-Direction (Ex Period sec Period s6C

Description ‘DPT‘ 1301/1302-61:2018 : Bangkok,Zone=3,1=1.0 R=4.0
Y-Direction (Ey

Damping Ratio
O Maximum Value 0 a [[] ¥-axis log scale

o.112387

Calculate

0K Cancel

Tarsional &mplhrcamo
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midas Gen | Gen 2022 v1.1 Release Note

6. Addition of Thailand DB(TIS for SI,MKS)

Added Concrete/Rebar DB and material as per TIS (for SI,MKS Unit system)

Set Rebar Material rete strength as per TIS

Preferences Material Data X

= Envi Design Code ILoad Code} General

Steel Concrete SAC Material ID Mame

Design Code: Design Code: Design Code:

] - = Elasticity Data
AlSC(15th)-LRFL ACI318M-14 A_ARCIK . -
Type of Design | Concrete
E Rebar Standard
Design/Load Code Fecommended .
Rehar Material Code DB

ggméwp et Gods iz Ctlz TISRC Rebar DB as per TIS & Design rebar settin Product
= Qutput Formats Design Code: (RC) | p g g

Farmats - Dim, & Others AlK-CFSDa8 TISIMESIRC Wiaterial DR CaREE

Formats - Fi Waterial OB Rebar Informaticn X
Fgmzé - Lgracdess _ SR24 v Standafd | TIS(MESIRC)

Fecommended - vpe of Material
Rebar Code TIS(MKS) ® Isotrapic Orthotropic

A T FIEa TTarot) | TVETgHt teel

7] Save Changes Upon OK Default All SetDefault || OK_ || Canc (mm) (mm?=) (mm) {tonfimm) adulus of Elasticity © 0.00002+00 M/mme
DBG 60000 | 222000 £.0000 0.0000 nisson’s Ratio : 1

DBa 2.0000 395000 £.0000 0.0000 hermal Coeffcient ¢ | 0,0000e+00] 1/C]
DB10 | 10.0000 | 61.6000 | 10.0000 0.0000
DB12 | 120000 | 88.8000 | 12.0000 0.0000
DB16 | 16.0000 | 157.8000 | 16.0000 0.0000 Uisa fiers Damsiilgs
DB20 | 200000 | 2466000 | 20.0000 0.0000 H Concrete

DB22 | 220000 | 298.4000 | 22.0000 0.0000 odulus of Elasticity i | 2 1924&+05] N mm:
DB25 | 250000 | 3853000 | 25.0000 0.0000 pisson’s Ratio ' oz

DB28 | 280000 | 433.4000 | 28.0000 0.0000 hermal Caefficient © 1.0000e-05 1,[C]
DB32 | 320000 | 6313000 | 32.0000 0.0000 sight Density o 23e 105
DB36 | 236.0000 | 799.0000 | 36.0000 0.0000
DB40 | 400000 | 9865000 | 40.0000 0.0000
RBB 6.0000 | 222000 £.0000 0.0000 Leticlty Data

RB3 8.0000 39,5000 8.0000 0.0000 ostic Matetial Name [NONE
RBY 90000 | 49.9000 9.0000 0.0000

RBAD 10.0000 51.6000 10.0000 0.0000 lastic Material Properties for Fiber Model
o PN A annann L pncrete |Wone « | Rebar None

Close

DB

9]
S
-

eight Density H 0 NAmme
MAmmesg

Rebar strength as per TIS

Tensile Strength| Yield Strength | Yield Strength
Fu (MPa) Fy (MPa) Fy (KSC)
385 235 2400
480 295 3000
560 390 4000
620 490 5000

M/mirne
[ Use Mass Density: 2.4e-09 N /mme/q

[

ermal Transfer

Specific Heat : D keal/M-[C]
Heat Conduction : D keal/mm-hr-[C]

Damping Ratin : |0.08

Cancel
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7. Addition of Taiwan DB(CNS560-18)

Added New Concrete/Rebar DB and Material as per CNS560-18

Set Rebar Material Concrete Material DB

Preferences X Material Data ®
=I- Environment Design Code ] Load Code General
- General .
Design Code: Design Code: . .
“Data Tolerances TWMN-ASDIS TWN-USD111 _—
Property TWN-SRC100 v Elasticity Data
Load . Steel
-Results Recommended Italy Rebar Type of Design Concrete w P
-Design/Load Code A Rebar Material Code Standar
-Notice. & Help Design Code: Material Code CNS560-18(RC) v DB
- Graphics CNS560-18(RC) ~ Product
Output Formats AISI-CFSDO8 > T Material DB roduc
- Formats - Dim. & Others SD280W ~
N W
.. Formats - Forces Foe—=r Concrete
.- Formats - Loads T Standard | CNSS0-18(RC) v
sD420 Type of Material .
SD420W (®) Isotropic Orthotropic
SD430W z = DE
Save Changes Upon OK. Default Al SO550W O | Cancel
50690 Steel
Modulus of Elasticity : 0.0000e+00 |kgffcm?
Rebar strength as per CNS560-18 Poisson’s Ratio ¢ g
Thermal Coeffident : 0.0000=400 | 1/[C]
Yield Strength Weight Density 0 |kgfjecm?
2 -
Fy (kgf/cm ) Use Mass Density: 0| kaffcm3fa
SD280 2,800 T
SD280W 2,800 Modulus of Elasticity : 175832 +05 | kgffem?
SD420 4,200 Poisson's Ratio : 0.167
SD420W 41200 Thermal Coeffident : 1.0000e-05 | 1/[c]
SD490W 5’000 Weight Density = 0.0024 kaffem?
SD550W 5,600 [ Use Mass Density: 2.4472-08 | kgffem3fg
SD690 7,000
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8. Addition of Indonesia DB(SNI)

Added Concrete/Rebar DB and material as per SNI

Set Rebar Material

Preferences

Design/Load Code
Motice & Help
.. Graphics
= Qutput Formats
Farmats - Dim. & Others
- Formats - Forces
i Formats - Loads

Steel
Design Code:
AISC{15th)-LRFL +

Recommended

Cold Formed Steel
Design Code:
AlIK-CFSD95

Recommended

Design Cade | Load Code |

Concrete
Design Code:
ACI318M-14

Fecommended

Febar
Material Code

SMI(RC)
Material DB

BiTP 260 v

FASave Changes Upon QK

Detault All

SRC
Design Code:
Al-SRC2K

Rebar
Material Code

SNI(RCY

Material DB
BiTP 280

| Rebar DB as per SNI & Design rebar setting

Gen 2022 v1.1 Release Note

rete strength as per SNI

Material Data

General
Material ID

Elasticity Data

Mame

Steel

Type of Desian | Concrete

Standard

Rebar Information

et

DB
Product

Concri

Rebar Code

BTE &

BITS 700

SMI

vpe of Material
[® Isotropic

(9]
I
-

Mame

Dia
(mm)

Area
(mm?=)

Dia(Out)
(mm})

Weight
(MN/mm)

Rebar strength as per SNI

Grade

Tensile Strength
Fu (MPa)

Yield Strength
Fy (MPa)

BjTP 280

350

280

BjTS 280

350

280

BJTS 420A

525

420

BjTS 420B

525

420

BjTS 520

650

520

BjTS 550

687.5

550

BjTS 700

805

700

MibAS

D6

6.0000

282740

6.0000

0.0022

Da

8.0000

50.2660

8.0000

0.0039

10.0000

78.5400

10.0000

0.0061

13.0000

1327330

13.0000

0.0102

16.0000

201.0620

16.0000

0.0155

19.0000

2835280

19.0000

0.0218

22.0000

3801340

22.0000

0.0293

25.0000

490.8750

25.0000

0.0378

29.0000

660.5210

29.0000

0.0503

32.0000

804.2500

32.0000

0.0619

36.0000

1017.8780

36.0000

0.0784

40.0000

1256.6400

40.0000

0.0967

50.0000

1963.5000

50.0000

01511

54.0000

2290.2260

54.0000

01763

I o

57.0000

2551.7650

57.0000

0.1964

Close

teel

isson's Ratio
ermal Coefficient

right Density

H Concrete

isson's Ratio
ermal Coefficient

right Density

sticity Data
stic Material Name

ncrete | None

ermal Transfer

Specific Heat

Heat Conduction

Damping Ratio

ndulus of Elasticity

Use Mass Density:

ndulus of Elasticity

Use Mass Density:

Standafd | SMI(RC)

Orthotropic 0B
0, 0000=+00
0
0,0000=+000 1/[C]
0 N/mme
MN/mms/g

MN/mm2

1.9378e+04
0.z
1.0000e-05
2.3564e-05
2.4e-09

M/mnmz
1/[C]

M/ mnrme

MN/mnme/g

MNONE

lastic Material Properties for Fiber Model

~ | HRebar Mone

: : keal/M-[C]
: D keal/mm-hr-[C]

=

Cancel
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9. Earthquake Scaling Calculator

m View

UNIT

Unit Preferences
System

Structure Node/Element Properties Boundary
L]

D n
;]l N E,
B i
-
Sectional Property Earthquake amidas

Calculator 5 S(alin_g = GSD
EEEEm amy
Generator

| < ||

=y =

:9:?

MGT Command
Shell

Command Shell

Load
b Bill of Material

;‘Mi Data Generator ~
E‘(g Convert Meta Files to DXF Files "1‘ % Auto Regen

Results Pushover Seismic Evaluation

Egjl

Design+«

Analysis Design Query

Y Generator

IZE'S Image

Full
Screen

Text Graphic | Customize
Editor Editor -

Dynamic Report

Earthquake Scaling Calculator

Input Data
Earthguake

Define Earthquake Functions

Earthquake 1 Earthquake 2

>
NN NN W NN N NN N NN N NN N NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN

nEarthquake Scaling Control
2 Method
® Amplitude

Scale Factor

% i Setting of Scaling

OUser 11383

() Frequency

[ Calculate i

Earthquake-1{x)
Earthquake-2{X)
Earthquake-3(X)

Earthquake-1(Y)
Earthquake-2(Y)
Earthquake-3(Y)

Input Seismic wave and
target spectrum

Damping Ratio © |0.05

Target Spectrum

Define Design Spectrum

B Apply the Same Amplification Factar

Amplification | »
factor
1.0000
1.0000
1.0000

Period (Sec)

0.0000| ~
0.0866| ~
0.4329| ~

0.0866
0.4329
6.0000

Target Period

Period (Sec)

0.3000] ~ |

[~ ] v

SEEENNN NN NNEENNNNNNNNNENNNNNNNNNNNNNNNNNNNNNNNNNNNNNNEEEEEEEEEEEEEER
:Hesult Graph

: Graph Type

: (®) Spectrum
L]

Earthquake

O Acceleration Mame :  |&ll

©.250312

0.230212 — L a
Target Spectrum
Design Spectrum
Average SRSS

0210312

0.180312

0170312

0150312

Check Scaling Results
and Export Results

za

0.130312

0.1l0312

Spectral Da

0.0503116

0.0703116

0.0503116

0.0303116

0.0103116

~0. 00568838 —

241 Z.EL
Bericd (sec)

2.z1

Gen 2022 v1.1 Release Note

method and scale factor

-Function : Scaling so that the average of the SRSS spectrum of the input seismic wave is greater than
or equal to the target spectrum for the target period

MibAS
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9. Earthquake Scaling Calculator

-Tools > Generator > Earthquake Scaling

Gen 2022 v1.1 Release Note

Earthquake Scaling Calculator

Input Data

Add/Medify/Show Earthquake Functions

Function Name

Earthquake-10X)

Import

Time Function Data Type

Mormalized Acceleration

..E.a:ﬂ:cru;l:e."""""""""""
ﬁ Define Earthquake Functions —2—»

Earthquake 1

>

Earthquake 2

Earthquake-1{X)

Earthquake-1(Y)

Earthquake-2{X)

Earthquake-2(Y)

Earthquake-3{X)

Earthquake-3(Y)

£
EEEEEEENEEEEEEEEEEEEEEN

Time
(sec)

Function
@)

Gravity

s

Enter seismic wave information considering

0.0200

0.0010

0.0400

0.0008

0.0600

0.0006

0.0800

0.0005

01000

0.0003

0.1200

0.0009

0.1400

0.0015

01600

0.0014

0.1800

0.0009

0.2000

0.0004

02200

-0.0001

0.2400

0.0010

the conditions of the ground where the
structure is located.
Import seismic waves saved as SGS files or

copy and paste input data into Excel format.

0.2600

0.0020

02800

0.0029

Description |

Cancel

Darnping Ratio :

0.05

6 Set the design response spectrum

'||'||'||'||'||'||'||'||'||'||'||'||'||'|ﬂ|'||'||'|ﬂn'||'||'|ﬂn'||'|ﬂn'||'|n'||:-

Target Spectrum

Define Design Spectrum

[ &pply the Same Amplification Factor

— P

Period (Sec)

factor

Amplification

>

~ | 0.0866

1.0000

~ | 0.4329

1.0000

~ | 6.0000

1.0000

]

FLEE 4
snY"'sEsEEEEEEEEEn

)

>

Generate Design Spectrum

Design Spectrum :

KDS(41-17-00:2019)

Design Spectral Response Acceleration

Selsmic Zone
EP&(S}
Site Class

1
022
32

~

~

Fa ‘ 1.38000 ‘

Sds (050600

| 9

Fu ‘ 1.36000 ‘

ad1 |D‘2024D

| 2

Importance Factar £le)
Fesponse Modification
Coef, (R)

1.2

~

Period (Sec)

EEEEEEEEEEEEEEEEEEEEEEEEEEES
6 Import Input Data Export Input Data
EEEEEEEEEEEEEEEEEEEEEEEEEEEES

ne
e TR L L]

Iax, Period : I:l (Sec)

Cancel

according to the standard and input the

magnification of the target spectrum.

6Set the scaling target period.

6Import and export input data as wzd files.
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9. Earthquake Scaling Calculator

-Tools > Generator > Earthquake Scaling

X Set the method and scale factor of earthquake scaling control.
Earthquake Scaling Contral

Mthad Scale Factor Check the scaling results in spectrum and acceleration graphs.
. ® Amplitude (O Frequency (® Auto Olger 11383

The scaled seismic wave results can be exported as SGS files or
time history functions or saved as Excel files.

E Calculate i
. Result Graph
Graph Type Earthquake
® Spectrum O Acceleration Marne @ |&ll

= Example of T.H function export

o Time History Analysis A/ Modify/Shows Time History Functions "
=) {T Time Farcing Functions : 6 Function Name Time Funcfion Dats Type |
8 Earthquake-10X0_1.1 @ Nomnalized Ascel. O Accaleration  OFarsa  OMoment (O Narmal
; Scale Factor Grautty Graph Opfions
Import | Eathquake| Heel Drop | @ Scale Factor || a6 |msec [ #-axis log scale
(] ¥-axis log scale

OFFT

£

.250212 — : Tme | Fondion | O Maximum Value

. (sec) (@)

| [ meem|ooeiz|

. 00400 00010

Q 0.0500 10,0007
10,0800 10,0005/
01000 0.0004
01200 0000
0.1400 00017
0.1600 00016
01800 00011
02000 .0005|
02200 0.0001
02400 00011

13 oaeo0| 00023

14| 0.2800 00033 ¥

-230312
Legend

Target Spectrum
= [esign Spectrum
.150312 i Average SRSS

-2l031z2

-170312 +

-150312

Description

.130312
Generate Earthquake Response Speckum. , a] [OF_]| Cancel || Aoply

= Example of excel export

[1] Earthquake-1(X), Earthquake-1(v) (Amplitude)

b.110312

- 0503116
Spectrum Acceleration (Earthquake-1(X))

0.350000
-0703116 ¥
0.300000

5 0250000
K]

0.0502116

sRSS

0.0303116 — ¥ Earthauake-100

5 0100000
Target

oas0090 SVl 2 o 050000

0.0103116 —

0.000090 -0.080000

100000
Period (sec) Time (sec)

-0.00568828

0. . . 1 - . 2.41 2.81
Pericd (sec)

Spectral Data (g) Acceleration Data (g)
Earthqua | Earthqua | - Time | Earthquak
ke-100 | ke-10) e | e100
0081256 | 0.073131 | 0109319 - 002 | 0001177
0081145 0109146 004| 0000959
0087088 009065 | - 006 | 0000738
CIDSE 0135739 0.160036 008 | 0000518
XE 0 0155443 | - 010 0.000383

6 Export Results to T.H Funcs, Export Results to 5G5S files Export Results to Excel
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10. Preview function of Start Page

-Personalized welcome message
-A section to see most recently used models
-Link to our technical knowledge site

Welcome to MIDAS

[MIDAS Blog] PP B [MIDAS Websinar]

Fundamentals of fou can doy : rsion of products RC Shell Design as per EC2
Seismic Isolation Analysis ickets] — Dec 13th 2021 - Dec 28th 2021

Recent

New Project CEV+003 Attivisolo SLVXY-211  : Def_design4 - ECO8 : Non-dis_COLUMN
209-GBA

slab(ACI318-14) : RC(ACI318-14) : : 210929 _Edificio Ensamble3
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11. Revit 2022 Interface

Gen-Revit Link
* File > Import > midas Gen MGT File | Functions |  Revit<>Gen |

Structural Column <>
= File > Export > midas Gen MGT File Beam <
- Brace <>
Rl et Curved Beam
. W e Beam System
: NAE " i s S ALPlaEs ™ TR i b dea Truss
|3 AN~ iy s A H-PlaE s~ A i b bR Foundation Slab <>
‘ - 3___ . - Ll _ Structural Floor <>
e - = oy ik (PR PborFeeSope e o Structural Wall <>
_____ ::M . - Wall Opening & Window >
. ) Door >
: 1 E‘N:‘“ ,.“N,o,,,,,vm::”:,wmw = \gifrst;Ctal or Shaft Opening :
o— i = C— == Cm— Rigid Link >
o — S Cross-Section Rotation >
s e End Release >
= —— Isolated Foundation Support >
Point Boundary Condition >
Line Boundary Condition >
I T g e e i Wall Foundation >
Area Boundary Condition >
Load Nature >
Load Case >
Load Combination >
Hosted Point Load >
Hosted Line Load >
Hosted Area Load >
- Material <>
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